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Note : (1) This question paper consists of 24 questions in all.

(i)  All questions are compulsory.

(iii) Marks are given against each question.

(iv) Section A consists of -

(a) Q.No. 1 to 8 — Multiple Choice Type Questions (MCQs) Q.No. 1 to 7
carrying 1 mark each and Q.No. 8 carrying 2 marks. Select and write the
most appropriate option out of the four options given in each of these
questions.

(b)  Q.No. 9 to 17 — Objective type questions, Q.No. 9 to 10 carry 02 marks
each (with 2 sub-parts of 1 mark each) and Q.No. 11 to 17 carry 01 mark
each.

(v) Section B consists of -

(a) Q.No. 18 and 19 — Very Short Answer type questions carrying 02 marks
each to be answered in the range of 30 to 50 words.

(b)  Q.No. 20 to 23 — Short Answer type questions carrying 03 marks each
to be answered in the range of 50 to 80 words.

(¢) Q.No. 24 — Long Answer type question carrying 04 marks to be answered
in the range of 80 to 120 words.

e : () 39 99 ¥ A 24 U 2|
(i) aN 997 orfrerd ¥
(iii) wd® U9T & 9w 8fd ™ ¥
(iv) @2 A ¥ i &:

(a) bed d& 19 8 — Sgfehedd ThX & UsH ¢ | U den 1 9 7 udk
1 37 1 & qUT U9 Gear 8 % fow 2 af ¥ 137 wowi ® ydw ® Yy ™
IR faeedl § 4 999 IugH fqbed g iR fafag)

(b) 9T T 9 ¥ 17 — IS UsT § | U7 T 9 ¥ 10 I 9T 02 3ichf
B ¥ (S SUNNT b WY YAh @l 1 3iw) X 49T e 11 9 17 ydsh
1 3% @& 3|

(v) @ B fm §:

(a) weT dE& 18 3R 19 — 3ifaeg Said U & UsT &, s & 02 oic
¥ 3T ST @ 91 30 9 50 9= B

(b) ueT T 20 § 23 — @Y ST Y &% YT €, YAh b 03 3ieh & 3K
I B GE 50 ¥ 80 9T ®)

(c) U9 T 24 — < AT YBIK BT U9 &, b 04 3ih € 3T 37X B
80 9 120 9= B
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NOTE / fader :

(1) Answers of all questions are to be given in the Answer-Book given to you.
gt gl % IR TR & TR IW YR H & fod |

(2) 15 minutes time has been allotted to read this question paper. The question
paper will be distributed at 02.15 p.m. From 02.15 p.m. to 02.30 p.m., the
students will read the question paper only and will not write any answer on
the answer-book during this period.

TH Y- hl Yed o foiw 15 fie o1 v feam T § 1 9eH-us o1 Ao Siaed
¥ 02.15 =t fopaam S@m| 02.15 &t 9 02.30 &S 0 S5 kel Y9HA-U5 il il
3R 39 emfy & SR 3§ SW-YRART W HIE S & fa@

SECTION — A /@9 - A

1  Which function is used to add a range of numbers in Excel? 1
T W Tohe HaeT T JIRT Uad b T {1 % QX %l US B o [T BIdl & 7
(A) ADD() (B) TOTAL( )
(C) SUM() (D) PLUS()

2 Why would you use the 'justify' alignment in a word document? 1

(A) To align text evenly between left and right margin

(B) To center the text

(C) To align text to the right

(D) to indent the first line of a paragraph

IS TS ¥ 1Y SIS YeTgTHe i G ol hid € 7

(A) RS B G &7 § A¥e ol Tge Wi % 9 T B & T
(B) o< @I <X § T@H & g

(C) e I Tge Uemed & % forg

(D) I BT Teel WIE §2 HIA b oy

3 Which formula is used to find the highest value in a range in Excel? 1
U H U IS & HioY q99 sifushad I e % fT g | B 91 Wi
SR B¢
(A) = Largest (Al : A10) (B) = MAX (Al : A10)

(C) = HIGHEST (Al : A10) (D) = BIGGEST (Al : A10)
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4  Why is it beneficial to use Bullets and Numbering in a document? 1
(A) To delete unnecessary text
(B) To present information in an organised way and to bring main points to
a reader's attention.
(C) To convert paragraphs in to tables.
(D) To add animation to the document.
T TES § goied iR AT YA B & T s 8 ¢
(A) eFTaYas Twe fEdie |
(B) =T %I HaRyd ¥9 | Usie & 3R Jed [§ga &l ues & & | A
(C) W ®Y o9 o gEAT
(D) TwEAs ¥ U TS BT

5 In MS Word, how do you apply a border to text? 1
(A) Page layout — Border and shading
(B) Insert - Border and shading
(C) Home — Paragraph — Border and shading
(D) View — Border and shading
TH TG 98 § MY SR & 919 s &y TS Bid & 7
(A) U WeeE — §EX uT QR
(B) 39 — iy dg 9fEm
(C) W — YmME — e Us i
(D) & — qEX vz g

6  This type of chart in a spreadsheet is used to compare values across categories. 1
(A) Pie chart (B) Line chart
(C) Bar chart (D) Scatter chart
T4 I BT TN Beslie # hamie X Rua @it degs & qaT e & fag fea
S
(A) i =ié (B) wmg =
(C) s ar (D) ®@heX dre

7  PowerPoint consists of different views to help you in the creation and 1
presentation of slides. Identify the incorrect one.
(A) Normal view (B) Slide sorter view
(C) Grid view (D) Slide show view

UieR Uige H ST ST S Bl § Sl STUeh WEsd I i 3= Yol Hid H Hag
XGRS LS I O e e B E | e

(A) e =g (B) wiige |iEX

© fr=g (D) wEe o =
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8 In the questions given below, there are two statements marked as 2
Assertion (A) and Reason (R). In each question options are given below.
Choose the correct option for your answer.

e fyw T wet & & wuw faw Tw ¥ R arfiees (A) o &R (R) & &9 ¥ fafesa
foran AT %1 U@® YT & A i U fasmedt § ° 92 faded gae IX iR
(i) Assertion (A) : Page Break is used to move content to the next page in
MS Word.
Reason (R) : Pressing "Enter" key multiple times is the best way to
start a new page in MS Word.
(A) Both (A) and (R) are true and (R) is correct explanation of (A).
(B) Both (A) and (R) are true but (R) is not the correct explanation of (A).
(C) (A) is true but (R) is false.
(D) (A) is false but (R) is true.
(E) Both (A) and (R) are false.
AUBIT (A) : TH T 9 H UF 9% b1 WAM Hee Bl o Ul  ¥o & faQ
BT 2|
%o (R) : U9 TF 9% ¥ UH A1 U 9[% B B G99 31T adew & "Enter”
% B B3 TN @G
(A) (A) 3T (R) < ®&1 € &fX (R), (A) &1 ¥ a1
(B) (A) 3R (R) 3Af @& & ug (R), (A) & e Ui 72 2|
(C) (A) & & g (R) Tod &1
(D) (A) Tad & 9T (R) Wel 21
(E) (A) 3R (R) 3N & 7eq &
(i1)) Assertion (A) : zip/unzip, anti-virus softwares are Utility programs.
Reason (R) :  Utility programs bridge the gap between the functionality of
an OS and the needs of users.
(A) Both (A) and (R) are true and (R) is the correct explanation of (A).
(B) Both (A) and (R) are true but (R) is not the correct explanation of (A).
(C) (A) is true but (R) is false.
(D) (A) is false but (R) is true.
(E) Both (A) and (R) are false.
st (A) : fqu/em fu, I 91 ¢ amrE |iveda i v & efaid
3 2 |
& (R) ¢ T Trm ST fagen ok gt &1 Sio il & 99 9y & &
H 2
(A) (A) 3T (R) EFf &1 € 87X (R), (A) &7 & aviF 2|
(B) (A) &R (R) 31 @21 ¥ wtg (R), (A) &1 9% aviF &f 2|
(C) (A) ®er & wg (R) Ted &1
(D) (A) Tad § 9 (R) Her &1
(E) (A) 3R (R) a4 & T &1

70/OSS/2-336-A 1 [ 5 [ Contd...



9  State True / False for the following : 2
(a) The 'Line and Paragraph Spacing' option is found under the Insert Tab.
(b) The 'Header and Footer', can contain text, page numbers, dates and images.
fr=fafad & 9 981Tad 9dEy
(a) FTWE 3T & it w@igd ofR WXumh WRET faded faar 1
(b) =X X HX # oMU TRe, U FaX, AI@ X 3991 ST Fohdl ¢ |

10 (a) The default page orientation in MS-Word is . 2
T TE g% ¥ dhiee U eNfdey ]
(b) To add a Header in a document, tab is used.
TS § g8 Bl SSH & WY < W YA B B
11 Store the format of each paragraph and if it is deleted, the text 1

in the paragraph becomes part of the next paragraph.

¥ g% YR &1 B WR eal & &R afs 38 fefee &2 faar sme ar
39 YUTH 1 TRE ST YT bl f&dr o S & |

12 represents the values of the data series plotted in the chart/graph. 1
ARG | W B 5 ST WS Bl I % B fe@ms S g1

13  The default alignment of text in MS Word is . 1
TH T 9 § TR A Ehice TaTgHe e ¥

14  When text needs to be pasted in a document, we use the short cut key R |

TE TR Dl SMELTRdT US4 UX Th q@iael ¥ U fopar oiar & a9 &°
JTEhe I BT TANT B & |

15 To change the page orientation, the tab is used and select orientation. 1
Ul enfXdey™ ggew & fog 29 @& WA B Td enfideym fadae wi
16 Instead of using a formula to add cell values, which feature can also be 1

used to automatically add numbers in the spread sheet cells.

Yo oSt e b T BT BT T B F I fhg WX & g o fear o
Tohar & e T e 8 & Fax offdiifes &9 9 U & 9|

17 The part of CPU which performs the Mathematical operations is called as 1
@ d g &1 a8 wer s i T ek ¥, HEATT & |
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SECTION — B /¥’ - B

18 Identify the following: 2

(a) An electromechanical hand held device used for point, click, drag and

drop actions.

(b) It translates printed images into an electronic format that can be stored

in a computer's memory and edited later.

(c) It is used by banks to convert the scanned image of a typed or printed

page into text that can be edited on the computer.

(d) It produces high quality print, extremely fast and quiet while printing,

can print up to 200 pages per minute.

3% Tl

(a) U Foa HAobliohet £ vee fearsd R uige, fomie, S, S Uaer & foTg e
fopan ST 7

(b) TE fUes AT B FOGLITD BIHS A ZEWS BIAT & 974 BT Bl AH § W
fopa ST wehar & o TR a1e o ufse fpan o 2|

(c) 3 d&f a1 AR fepar wirar & fad ey a1 fiRe U9 WX Reua 3u &t w@he
Pk TRS § Hae (ohdl oIl ¢ T8 Hrgey UX Ufse fopam <11 |ehalm 2|

(d) T% sEFETel fie 31 &, I8 §§d a9 A ° B BT & SR o0id G ¥ fie
BT & 3T 399 uid e 200 99 fiie & @ed 21

19 Explain the two types of application software each with an example. 2

3 Yh & UIhH AFEIaT hl T Teh S8 & 1Y o Y|

20 Explain the role of the documents involved in Mail Merge in MS Word. 3
T TE 95 W 99 A9l A A SwrEstt &l e B aue Bl
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21

22

23

24

Explain system software with its types.
feeH Qiweday ok 39 YhRI & U |
OR / 3@t

What are low level languages? Explain its types.

W I 9T T BT & ¢ 58P YT Bl IU Dl |

Explain the role of the following in Internet:

(a) ISP (b) URL
(c) ISDN

doie ¥ B B R & au w:

(a) org wE (b) g R TH
(c) omg ud & T

ABC School is organizing its annual day celebration and wants to send
invitation letters to parents. The school has a list of parent's names and addresses
stored in an Excel File. Instead of typing each letter manually, they decide to
use Mail Merge in MS Word. Explain the steps involved in merging the Excel
File with the Word Document for this case.

ABC & & aiities oo A7man S Te1 & SR el aifyeras! &t Fsmr o 99 S
g e W SAMHTES & M AR UgH @l e Uad BiEd | U9 g1 T&E Wl @
ST STAT W BT & q9NMY I 38 TA UH I8 & A A9l § Wl 9B & |
TET B b W fag |

(a) Differentiate between a web server and web browser with an example
of each.
g FAY 8iX I9 T8 & 919 AT Iq T YA hl Tdh Teh IaTEL S|
(b) Explain the role of the "cc" and "bcc" while composing email.

A B BT I "cc" SR "bee" B YRR B AU B
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in the Question Paper are the same as those printed on the top of the first page. Also check to
see that the questions are in sequential order.

3. Making any identification mark in the Answer-Book or writing Roll Number anywhere other than
the specified places will lead to disqualification of the candidate.
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Answer-Book.
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DATA ENTRY OPERATIONS (Theory)
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(336)

[Maximum Marks : 40

qag : 2 9] [quiiss : 40
Note : (1) This question paper consists of 24 questions in all.

(i)  All questions are compulsory.

(iii) Marks are given against each question.

(iv) Section A consists of -

(a) Q.No. 1 to 8 — Multiple Choice Type Questions (MCQs) Q.No. 1 to 7
carrying 1 mark each and Q.No. 8 carrying 2 marks. Select and write the
most appropriate option out of the four options given in each of these
questions.

(b) Q.No. 9 to 17 — Objective type questions, Q.No. 9 and 17 carry 02 marks
each (with 2 sub-parts of 1 mark each) and Q.No. 10 to 16 carry 01 mark
each.

(v) Section B consists of -

(a) Q.No. 18 and 19 — Very Short Answer type questions carrying 02 marks
each to be answered in the range of 30 to 50 words.

(b)  Q.No. 20 to 23 — Short Answer type questions carrying 03 marks each
to be answered in the range of 50 to 80 words.

(¢) Q.No. 24 — Long Answer type question carrying 04 marks to be answered
in the range of 80 to 120 words.

e : () 39 99 ¥ A 24 U 2|
(i) aN 997 orfrerd ¥
(iii) wd® U9T & 9w 8fd ™ ¥
(iv) @2 A ¥ i &:

(a) bed d& 19 8 — Sgfehedd ThX & UsH ¢ | U den 1 9 7 udk
1 37 1 & qUT U9 Gear 8 % fow 2 af ¥ 137 wowi ® ydw ® Yy ™
IR faeedl § 4 999 IugH fqbed g iR fafag)

(b) UT w9 | 17 — aGFTs U T UeT WA 9 &R 17 &k e 02
3kl T ¥ (ST SYNTT & AT T o1 1 3feh) 37T w9 g&an 10 ¥ 16 3%
1 3% @& 3|

(v) @ B fm §:

(a) weT dE& 18 3R 19 — 3ifaeg Said U & UsT &, s & 02 oic
¥ 3T ST @ 91 30 9 50 9= B

(b) ueT T 20 § 23 — @Y ST Y &% YT €, YAh b 03 3ieh & 3K
I B GE 50 ¥ 80 9T ®)

(c) U9 T 24 — < AT YBIK BT U9 &, b 04 3ih € 3T 37X B
80 9 120 9= B
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NOTE / fidur :

(1) Answers of all questions are to be given in the Answer-Book given to you.
ol Tl o IR TR & TR W gfaen § & fod |

(2) 15 minutes time has been allotted to read this question paper. The question
paper will be distributed at 02.15 p.m. From 02.15 p.m. to 02.30 p.m., the
students will read the question paper only and will not write any answer on
the answer-book during this period.

TH -9 ! UgH o foiq 15 fiee w1 T foom mn ® 1 9eA-uo o1 ferror el |
02.15 =<1 foham ST@m 1 02.15 =1 ¥ 02.30 It Tk BT shaiel Y99-951 bl Ui 31K 39
3 % SR o SW-YRahT | HIE IW &I ferai |

SECTION — A /@9 - A

1  Which Excel function is used to determine the lowest value in a range? 1
fone UoRie thareT ol JAINT Ueh {o1 o WA <o d¢g Mebra- o e giar & 7
(A) MIN() (B) MAX()
(C) MINIMUM( ) (D) FLOOR()

2 Which formula is used to find the highest value in a range in Excel? 1

U # U IS & HIoY 999 sifushad I e % T g | B d1 Wi
SR B¢

(A) = Largest (Al : A10) (B) = MAX (Al : Al10)
(C) = HIGHEST (A1 : A10) (D) = BIGGEST (A1l : A10)
3 What does the formula = COUNT (A1l : A10) do? 1

(A) Counts the total number of numeric values in the range
(B) Adds up all the values in the range

(C) Counts both text and numbers in the range

(D) Finds the maximum value in the range

wrem = COUNT (Al : A10) &1 &ear &7

(A) U & H AN Ieg B densll & Ha e [T §|
(B) ©H (& @ gl st & S ¥

(C) X # e o dwmsll sl &l Rl & 5|

(D) (& o aifepam I Teraar 1
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4  How can we add Headers and Footers in our document? 1
AT T ¥ 7 Y o ged B OE w7
(A) Select Insert -> Header and Footer
(B) Select View -> Header and Footer
(C) Select Paragraph -> Header and Footer
(D) Select Home -> Header and Footer

5  Why would you use the 'justify' alignment in a word document? 1
(A) To align text evenly between left and right margin
(B) To center the text
(C) To align text to the right
(D) to indent the first line of a paragraph

< TS | Y TS UATETHE BT FART Ff Bl & 7

(A) TR B GAM T § WU X IS AN b drd UeTEA B & foQ
(B) e & ¥X ¥ @A & fog

(C) 2o i g UAEA Hid o foiy

(D) % B TEW! AIEA I8 B & [AQ

6  Which function is used to add a range of numbers in Excel? 1
T W [p B T TN U % b (ST o el bl US B % (o1Q BT & 7
(A) ADD() (B) TOTAL()
(C) SUM() (D) PLUS()

7  The is the view to use when you preview your presentation to make 1

sure everything is in place, or when you deliver a presentation to an audience.

(A) Slide sorter (B) Slide show

(C) Outline (D) None of the above

TS Y 39Tl % T YS9 YR BAd & AT S Y I8 @1 A18d § b
Uy W U9 ol GE We W ¥, a9 8 I YA B 2|

(A) wiEE |k (B) wmEs o

(C) om3e @ (D) SWie W ¥ B3 Tl
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8 In the questions given below, there are two statements marked as 2
Assertion (A) and Reason (R). In each question options are given below.
Choose the correct option for your answer.

e fyw T wet & & wuw faw Tw ¥ R arfiees (A) o &R (R) & &9 ¥ fafesa
foran AT %1 U@® YT & A i U fasmedt § ° 92 faded gae IX iR
(i) Assertion (A) : Page Break is used to move content to the next page in
MS Word.
Reason (R) : Pressing "Enter" key multiple times is the best way to
start a new page in MS Word.
(A) Both (A) and (R) are true and (R) is correct explanation of (A).
(B) Both (A) and (R) are true but (R) is not the correct explanation of (A).
(C) (A) is true but (R) is false.
(D) (A) is false but (R) is true.
(E) Both (A) and (R) are false.
AUBIT (A) : TH T 9 H UF 9% b1 WAM Hee Bl o Ul  ¥o & faQ
BT 2|
%o (R) : U9 TF 9% ¥ UH A1 U 9[% B B G99 31T adew & "Enter”
% B B3 TN @G
(A) (A) 3T (R) < ®&1 € &fX (R), (A) &1 ¥ a1
(B) (A) 3R (R) 3Af @& & ug (R), (A) & e Ui 72 2|
(C) (A) & & g (R) Tod &1
(D) (A) Tad & 9T (R) Wel 21
(E) (A) 3R (R) 3N & 7eq &
(i1)) Assertion (A) : zip/unzip, anti-virus softwares are Utility programs.
Reason (R) :  Utility programs bridge the gap between the functionality of
an OS and the needs of users.
(A) Both (A) and (R) are true and (R) is the correct explanation of (A).
(B) Both (A) and (R) are true but (R) is not the correct explanation of (A).
(C) (A) is true but (R) is false.
(D) (A) is false but (R) is true.
(E) Both (A) and (R) are false.
st (A) : fqu/em fu, I 91 ¢ amrE |iveda i v & efaid
3 2 |
& (R) ¢ T Trm ST fagen ok gt &1 Sio il & 99 9y & &
H 2
(A) (A) 3T (R) EFf &1 € 87X (R), (A) &7 & aviF 2|
(B) (A) &R (R) 31 @21 ¥ wtg (R), (A) &1 9% aviF &f 2|
(C) (A) ®er & wg (R) Ted &1
(D) (A) Tad § 9 (R) Her &1
(E) (A) 3R (R) a4 & T &1
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9 (a) The default page orientation in MS-Word is . 2

T T 9% § Shiee U9 SNy ]
(b) To add a Header in a document, tab is used.
TS H £8¢ @l e & fag 9 &1 TENT BT B
10  Store the format of each paragraph and if it is deleted, the text 1

in the paragraph becomes part of the next paragraph.
7 ydd T B HiHE ©R BT ¢ SR Afe 39 fEfae & faan S ar
G YOUTH 1 TS ST YUTH bl f&&qT o a8 |

11 represents the values of the data series plotted in the chart/graph. 1
AR/ § T B T3 ST WISl Bl IS % F0 e S E

12 The default alignment of text in MS Word is . 1
TH T I8 ¥ SRS & SIhice TARTHE B

13 When text needs to be pasted in a document, we use the short cut key N |

E TR Bl SMELTRdT IS+ UX Th q@rael ¥ U fopar oiar & a9 &°
JMShe I BT TATT B & |

14 To change the page orientation, the tab is used and select orientation. 1
Ul MUY 98eq & g 29 B YA B Td My e #i|
15 Instead of using a formula to add cell values, which feature can also be 1

used to automatically add numbers in the spread sheet cells.

A IS Wiy &b T BT & YA B b IId fBH W w1 GERT | fRar o
Tohar & e T e 8 & Fax offdiifes &9 9 U & |

16 The part of CPU which performs the Mathematical operations is called as 1
0 g & 9% A0 fEH I e g E, HEATT & |
17 State True / False for the following : 2

(a) The 'Line and Paragraph Spacing' option is found under the Insert Tab.
(b) The 'Header and Footer', can contain text, page numbers, dates and images.
frefafaa & 9 @@/ d IaEy ¢

(a) TWS T P I W3 SN U WA ferehed freram ¥

(b) TS IR FX H Y e, U FaY, AW X IS ST Hovdl ¢ |
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SECTION — B/ ¥’ - B

18 Which peripheral device you will recommend for the following situations: 2
(a) Is an input device, which takes voice as input.
(b) It is a small size plotter to be kept on table with restriction of paper size.

(c) This is a typical monitor looking like a television screen and uses a large
vacuum tube.

(d) This type of printer creates an image directly on paper by spraying ink
through as many as 64 tiny nozzles and offers an excellent middle ground
between dot matrix and laser printer.

1 ufiRafort & fog oo fpe e feamgw @1 qaw 7

(a) 9% Uh 3Y< feamsy & W A0q & 3192 & &9 § ol 5|

(b) T UH BIE AHR HT @eX ¢ 4 2q@ U T@T A1 Gbal o

(c) % AT & & I & BhF &I aE T & oY 3UH S JH [ B AN
T 5

(d) =T YBR & X 31ue 64 B Atad o WEl 5w T @e SR X fas sraar
¥, U9 e e Afew wd o fie % 99 ue Aoyt Rufy w@ar ¥

19 Identify the following: 2
(a) An electromechanical hand held device used for point, click, drag and
drop actions.
(b) It translates printed images into an electronic format that can be stored
in a computer's memory and edited later.

(c) It is used by banks to convert the scanned image of a typed or printed
page into text that can be edited on the computer.

(d) It produces high quality print, extremely fast and quiet while printing,
can print up to 200 pages per minute.

3% TEEI:

(a) TH 0 FbiTohel &< Tos feargq 8 uige, forta, S1, S0 Tae™ & forg it
fopan ST ®1

(b) Tz fiiee AT &l TAaIH HiHe § AWS HIAT & 8 BT B T § ©R
fopan < wpar ¢ o fA §1@ ¥ uwiee fopam wmar @1

(c) = di g v fpan Sar @ fed 2w A fide 9w W Rua Ew @ WA
H{h TRS § Hae [hdl oIl & T8 wrgey UX Ufse fpam =11 wepa 2|

(d) T% sEFTel fie 31 &, I8 S§d O A ° B BT & R oOid 4G 9 fie
BT & R @8 wfq fme 200 99 fii & @&d ¥
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20 Explain system software with its types.
feeH Qiweday ok 39 YhRI & U 6|
OR / 3@t

What are low level languages? Explain its types.

W I 9IS T Bl & ¢ 3HB YT Bl Iu hi |

21 Explain the role of the following in Internet:

(a) ISP (b) URL
(c) ISDN

detie & P @ i & @

(a) oM Tg W (b) g & ud
(c) o w§ &1 o

22 ABC School is organizing its annual day celebration and wants to send

invitation letters to parents. The school has a list of parent's names and addresses
stored in an Excel File. Instead of typing each letter manually, they decide to
use Mail Merge in MS Word. Explain the steps involved in merging the Excel
File with the Word Document for this case.

ABC e # a1itics feerd w9 <11 (@1 & o ¥l St Hiae! &l FeE o 9 S
T Tpa ¥ fHTasl & AW SR U3 @l e Uee BiRd ¥ 99 ¥ UdE Wl @l
IO T <139 % & 9T d 39 UH U9 I &0 Ao 990 § 9o ared & |
UHT & b © g |

23 Explain the role of the documents involved in Mail Merge in MS Word.
T TE 95 W 9d A9l A SNHA SwrEstt @l e B auie Bl

24 (a) Differentiate between dial-up and leased line connections.
SRS 3 Wivs 3T Haerd & S/ 3idt W Hifd |
(b) Name and explain the parts of an email.

U & AT 1 A fod 8k SeRt v @Y |
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Note : (1) This question paper consists of 24 questions in all.

(i)  All questions are compulsory.

(iii) Marks are given against each question.

(iv) Section A consists of -

(a) Q.No. 1 to 8 — Multiple Choice Type Questions (MCQs) Q.No. 1 to 7
carrying 1 mark each and Q.No. 8 carrying 2 marks. Select and write the
most appropriate option out of the four options given in each of these
questions.

(b)  Q.No. 9 to 17 — Objective type questions, Q.No. 9 to 10 carry 02 marks
each (with 2 sub-parts of 1 mark each) and Q.No. 11 to 17 carry 01 mark
each.

(v) Section B consists of -

(a) Q.No. 18 and 19 — Very Short Answer type questions carrying 02 marks
each to be answered in the range of 30 to 50 words.

(b)  Q.No. 20 to 23 — Short Answer type questions carrying 03 marks each
to be answered in the range of 50 to 80 words.

(¢) Q.No. 24 — Long Answer type question carrying 04 marks to be answered
in the range of 80 to 120 words.

e : () 39 99 ¥ A 24 U 2|
(i) aN 997 orfrerd ¥
(iii) wd® U9T & 9w 8fd ™ ¥
(iv) @2 A ¥ i &:

(a) bed d& 19 8 — Sgfehedd ThX & UsH ¢ | U den 1 9 7 udk
1 37 1 & qUT U9 Gear 8 % fow 2 af ¥ 137 wowi ® ydw ® Yy ™
IR faeedl § 4 999 IugH fqbed g iR fafag)

(b) 9T T 9 ¥ 17 — IS UsT § | U7 T 9 ¥ 10 I 9T 02 3ichf
B ¥ (S SUNNT b WY YAh @l 1 3iw) X 49T e 11 9 17 ydsh
1 3% @& 3|

(v) @ B fm §:

(a) weT dE& 18 3R 19 — 3ifaeg Said U & UsT &, s & 02 oic
¥ 3T ST @ 91 30 9 50 9= B

(b) ueT T 20 § 23 — @Y ST Y &% YT €, YAh b 03 3ieh & 3K
I B GE 50 ¥ 80 9T ®)

(c) U9 T 24 — < AT YBIK BT U9 &, b 04 3ih € 3T 37X B
80 9 120 9= B
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NOTE / fadwr :

(1) Answers of all questions are to be given in the Answer-Book given to you.
ol Tl o IR TR & TR W gfaen § & fod |

(2) 15 minutes time has been allotted to read this question paper. The question
paper will be distributed at 02.15 p.m. From 02.15 p.m. to 02.30 p.m., the
students will read the question paper only and will not write any answer on
the answer-book during this period.

TH -9 ! UgH o foiq 15 fiee w1 T foom mn ® 1 9eA-uo o1 ferror el |
02.15 =<1 foham ST@m 1 02.15 =1 ¥ 02.30 It Tk BT shaiel Y99-951 bl Ui 31K 39
3 % SR o SW-YRahT | HIE IW &I ferai |

SECTION - A /€% - A

1  This feature of Excel 2007 allows you to draw a number of geometrical 1
shapes, arrows, flow chart elements, stars and more on the worksheet.
(A) legends (B) autoshape
(C) data labels (D) smart art

T 2007 T I8 HIa 3TUh! S5 T S SThiol, U, Tl a1 Taried,
W 3MfE BT qehsiie S & STFAfT <ar & |

(A) wivied (B) ameigr
(C) ==l ey (D) & e

2 Which function is used to add a range of numbers in Excel? 1
T W p AT T YA UHRIA % T (ST o X bl US B o foTQ Bl & 7
(A) ADD() (B) TOTAL()
(C) SUM() (D) PLUS()

3 A teacher wants to calculate the average marks of 10 students in a class. 1

Which Excel function should she use?

U fyrferet wem & 10 B &% ofad sk et amedt 81 39 U fope T has™
%1 IUGNT M1 TT(eT 7

(A) = SUM (Al : A10) (B) = AVERAGE (Al : A10)
(C) = COUNT (Al : A10) (D) =1F (Al : A10)
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4  Which of the following is not a feature in MS-Word? 1
(A) Page Borders and Shading
(B) Spell Check
(C) Automatic Calculation
(D) Find and Replace

TTH Y T UH TE 98 h Uk Bl el § 7
(A) U LY U QfET (B) @&« %
(C) ofiddfed PAFas (D) wrEE s e

5  Why would you use the "justify' alignment in a word document? 1
(A) To align text evenly between left and right margin
(B) To center the text
(C) To align text to the right
(D) to indent the first line of a paragraph
IS TS 7 11T TGS UASTHE BT FANT &l B © 7
(A) TRE B GUH BT Y AF ST TEE WA &b S UeEA B b fAg
(B) 2o &l X | @A & MU
(C) 2o i g UAEA ®HId o foiy
(D) A% & YEel WET 32 B b g

6  Which formula is used to find the highest value in a range in Excel? 1
U § T (o1 & Wi 999 sifashad Ieg e & fdu 399 & & a1 wiven
SUYFH TR ?

(A) = Largest (Al : A10) (B) = MAX (Al : A10)
(C) = HIGHEST (A1 : A10) (D) = BIGGEST (Al : A10)
7  To duplicate a slide in PowerPoint which of the following is used? 1
Witz ¥ U WSS w1 AR B H R T A Reae TN e § 7
(A) Shift+D (B) Ctrl+S
(C) Alt+D (D) Ctrl+Shift+D
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8 In the questions given below, there are two statements marked as 2
Assertion (A) and Reason (R). In each question options are given below.
Choose the correct option for your answer.

e fyw T wet & & wuw faw Tw ¥ R arfiees (A) o &R (R) & &9 ¥ fafesa
foran AT %1 U@® YT & A i U fasmedt § ° 92 faded gae IX iR
(i) Assertion (A) : Page Break is used to move content to the next page in
MS Word.
Reason (R) : Pressing "Enter" key multiple times is the best way to
start a new page in MS Word.
(A) Both (A) and (R) are true and (R) is correct explanation of (A).
(B) Both (A) and (R) are true but (R) is not the correct explanation of (A).
(C) (A) is true but (R) is false.
(D) (A) is false but (R) is true.
(E) Both (A) and (R) are false.
AUBIT (A) : TH T 9 H UF 9% b1 WAM Hee Bl o Ul  ¥o & faQ
BT 2|
%o (R) : U9 TF 9% ¥ UH A1 U 9[% B B G99 31T adew & "Enter”
% B B3 TN @G
(A) (A) 3T (R) < ®&1 € &fX (R), (A) &1 ¥ a1
(B) (A) 3R (R) 3Af @& & ug (R), (A) & e Ui 72 2|
(C) (A) & & g (R) Tod &1
(D) (A) Tad & 9T (R) Wel 21
(E) (A) 3R (R) 3N & 7eq &
(i1)) Assertion (A) : zip/unzip, anti-virus softwares are Utility programs.
Reason (R) :  Utility programs bridge the gap between the functionality of
an OS and the needs of users.
(A) Both (A) and (R) are true and (R) is the correct explanation of (A).
(B) Both (A) and (R) are true but (R) is not the correct explanation of (A).
(C) (A) is true but (R) is false.
(D) (A) is false but (R) is true.
(E) Both (A) and (R) are false.
st (A) : fqu/em fu, I 91 ¢ amrE |iveda i v & efaid
3 2 |
& (R) ¢ T Trm ST fagen ok gt &1 Sio il & 99 9y & &
H 2
(A) (A) 3T (R) EFf &1 € 87X (R), (A) &7 & aviF 2|
(B) (A) &R (R) 31 @21 ¥ wtg (R), (A) &1 9% aviF &f 2|
(C) (A) ®er & wg (R) Ted &1
(D) (A) Tad § 9 (R) Her &1
(E) (A) 3R (R) a4 & T &1
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9  State True / False for the following : 2
(a) The 'Line and Paragraph Spacing' option is found under the Insert Tab.
(b) The 'Header and Footer', can contain text, page numbers, dates and images.
fr=fafad & 9 981Tad 9dEy
(a) FTWE 3T & it w@igd ofR WXumh WRET faded faar 1
(b) =X SR HX # oMU TRe, U FaX, AI@ X 391 ST Fohel ¢ |

10 (a) The default page orientation in MS-Word is . 2
T TE @ A i U9 Sy 2
(b) To add a Header in a document, tab is used.

TS o ST Bl SeT & oy 9 &1 WM B B

11 The part of CPU which performs the Mathematical operations is called as 1

o dr g &1 a8 wrr fed Tid T ek E, HEATT & |

12 Instead of using a formula to add cell values, which feature can also be 1
used to automatically add numbers in the spread sheet cells.

G Il S % T BT B T4 BT & qao0 (hF WX B qamT A fpar o
b1 & 8 @ ofie 9 & HaX ofieifes vU 9 U & w |

13  To change the page orientation, the tab is used and select orientation. 1
Ul MUy 98eq & g 29 & YA B Td iy e &Y
14 When text needs to be pasted in a document, we use the short cut key N |

TE TR Dl SMELTRdT IS+ UX Tdh q@iael § U fopar oian & a9 &°
JTEhe i BT TANT B & |

15 The default alignment of text in MS Word is . 1
TH T 9% ¥ SRS & SIhice TARTHe B

16 represents the values of the data series plotted in the chart/graph. 1
ARG F W B g ST WS B I % B fe@s S §1

17 Store the format of each paragraph and if it is deleted, the text 1

in the paragraph becomes part of the next paragraph.
¥ Yo IO @ B &R ST & oiR atg 39 fefie o faar s
9 YUTH T TRE ST UXTH bl f&edr o i &1
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SECTION — B/ ¥’ - B

18 Give an example of: 2

(a) A system software that provides an interface for a user to communicate
with the computer.

(b) System softwares that help in maintenance a computer system.

(c) A high level language.

(d) An application software for making Spreadsheets

Y% &1 T SR &

(a) Ueh AHRGUX SN HFYX & G HaE 6 & [0 POk Bl Th THH Ya
HIT 2

(b) " HiFedwX o HrgeX A & A=+ ¥ Agg &Ll ol

(c) TH &E Waw W

(d) TH UwihIE WiHEEX W Sresiiey JAR B B

19 Identify the following: 2

(a) An electromechanical hand held device used for point, click, drag and
drop actions.

(b) It translates printed images into an electronic format that can be stored
in a computer's memory and edited later.

(c) It is used by banks to convert the scanned image of a typed or printed
page into text that can be edited on the computer.

(d) It produces high quality print, extremely fast and quiet while printing,
can print up to 200 pages per minute.

3% Bl

(a) TS Ioiael Hobfiohdt & woe feazy fd uide, fotes, 371, 310 Ude™ & forw v
fepar wiam B

(b) TE T TN B SFITb BIHS | ZIEWE BIAT & 974 BT Bl AA § WX
fopar < TR & @R AT @1 ® ufee fopan wam B

(c) 3§ Jaf g v fopan wimar @ e ey a1 fids o9 9 Reud 38 & @6
B RS | Hae fpar oan & T wrgeX uX ufse femar S dendn 1

(d) @7 TEFEee fiie <a1 2, 9% §gd a9 T ¥ BM Bal & iR orid Wia ¥ fife
HAT & R AN wia fre 200 oW fiie & gd )
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20 Explain system software with its types.
foeeA Qiweday o 39 UHRI &l U @l |
OR / 3@t

What are low level languages? Explain its types.

W g 9T T Bl & ¢ SHP WehTA bl Iue hi |

21 Explain the role of the following in Internet:

(a) ISP (b) URL
(c) ISDN

ez # Fre a1 e B o a5

(a) &g wE 0 (b) 7 oM ud
(c) o wd & u

22 ABC School is organizing its annual day celebration and wants to send

invitation letters to parents. The school has a list of parent's names and addresses
stored in an Excel File. Instead of typing each letter manually, they decide to
use Mail Merge in MS Word. Explain the steps involved in merging the Excel
File with the Word Document for this case.

ABC wa ® aifies e A7man S T@1 ¢ S et aifyras! &1 s o 9 s
Tl wpat ® orfivraasl & AW oiR Tgd @ fie Yid wrRd ® ¥9 ¥ Ud® Wl @l
3TET ST 2139 %A & I I 3 UH TF I8 g1 97 91 § Wl ded 2|
T B & = o |

23 Explain the role of the documents involved in Mail Merge in MS Word.
T TE 95 W 9d A9l A SNHA Serastt @) et B auie Bl

24 (a) What is the role of a web browser? Name any 2 web browsers.

IT TS DI et F1 ¢ 7 =l &1 99 Feek % AW and |
(b) Differentiate between Telnet and FTP.
TS o UH & U & 99 Sfay W &L
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